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1 Introduction

BPManager is similar to e-mail in many ways, offering a method of sending messages and file
attachments to other BPManager users.
But BPManager is also unique, offering three distinct kinds of messages:
· Requests
· Notifications
· Request Responses

BPManager allows the user to establish 'request types' and 'templates' for recurring kinds of
requests.

BPManager is also similar in many ways to work-flow management software.  But BPManager is
usable immediately on installation without extensive business process analysis.  Rather than
conforming to strict pre-defined business processes, BPManager offers an adaptable method for
filing, delegating, and completing requests within the organization. BPManager is designed so that
managers and designated employees can add to, modify, and adjust the behaviour of business
processes on the fly.

2 Basic Capabilities

· BPManager is used to issue requests to other participants of the SLAP system.

· Various items may be attached to the requests, such as:
1. a document or file, or
2. a hyperlink, or
3. a link to application software such as an order or estimate number.

· Participants may be specific, named individuals (users), or identified by title or department
(groups).

· The request recipient may delegate, reject or complete the request.

· Notifications of request actions may be sent over the SLAP network, by e-mail, fax, or by using
an SSI product called Pipex.

· Each participant can use the BPManager program to handle outstanding requests, to review
requests made, to read notifications, and to issue new requests.

· 'Request types' can be added by authorized personnel, such as managers to handle recurring
requests.  Requests of a given type are automatically routed to certain groups or users, and
trigger subsequent requests on completion.

· Requests may, but do not have to be categorized by type.

· Requests can be stand-alone or automatically connect to the software program required to fulfill
the request, such as a Purchase Order program within an ERP system.  (Not available in
version 0.9)

· Requests can be triggered by application software through an API.  (Not yet available in
version 0.9)



Features 4

© 2003 Slofstra Software Inc.

3 Features

3.1 A sequence of requests can be pre-defined, but it is not necessary

Request completion, delegation, or rejection can trigger a new request.  The system can be set up
so that a new request is triggered every time a request of a certain type is completed (or
delegated or rejected), or the user can choose to add a next step request to any individual
request sent out. Notifications also be established for every request of a particular type, or for
individual requests.

Here is an example: When a new drawing is received from the customer by a customer liaison,
you might like to send the drawing to Engineering.  When the drawing has been reviewed,
Estimating must determine if a new estimate should be developed.  To handle this, you would
create two request types - "Review drawing" which is handled by Engineering, and "Review for
estimate" handled by  the Estimating Manager.  When Engineering indicates that "Review
drawing" is complete, the "Review for estimate" action can be triggered automatically. If desired,
the engineering department can be sent a draft of the action for release, before the action is sent
to Estimating.

see 
New Request: Next Step TAB
New Request: Notify TAB
Maintain Request Type: Next Step TAB
Maintain Request Type: Notification TAB

3.2 Requests can be cancelled, rejected or delegated

The requester can cancel a request at any time before completion by the request recipient. The
request recipient has three options: complete the request, reject it or delegate it. The original
requester can trigger another request for any or all of these actions, and can also determine who
to notify.  Or, a subsequent request can be set up so it is triggered every time a
request of a given type is completed, rejected or delegated.

3.3 Recipient can either be a user or a group

Request can be directed to a specific participant by name, or by responsibility or department.  The
latter cases are handled through setting up 'groups'.  For example, EstimatingDepartment might
be a group.  But, EstimatingManager could also be set up as a 'group'. This allows requests to be
directed to whoever bears the EstimatingManager title.

3.4 Flexible attachment types

BPManager supports two kinds of attachments:

· Files, such as a Word .DOC file, or an AutoCAD .DWG drawing
· Pointers to objects in an ERP system (or other application software), such as a Customer

Request Form or an Order

File attachments are simply uploaded to the server and distributed to the request recipient(s) who
can download them to his or her PC and view them.

Pointers to objects can be accessed through hyperlinks to the ERP system. For example, clicking
on an Order attachment brings up the view order page for the selected order.
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3.5 Mandatory attachments

Certain requests can only be sent when an object is attached. For example, a "Change Estimate"
request might require an existing estimate to be attached. Other attachments may be optional,
for example a "fix bug in program" request may or may not include a screen capture of the error
message.

Other attachments may be required not when a request is made, but when it is completed or
cancelled. For example, a "Create estimate" request can only be marked completed if the new
estimate number is attached.

Whether a request requires an attachment or not can be set up through the
Request Type Maintenance.

3.6 Automatic tracking of chains

In BPManager, a "chain" is a sequence of requests or notifications.  These sequences do not need
to be pre-defined in the BPManager system.

BPManager tracks chains of requests as they occur. Reports can be extracted from the system to
reveal the business process implicit in the chains.

The advantage of this approach is that managers can use the BPManager system to "get the job
done", in the same order and progression they do today.  BPManager provides an immediate
benefit in improving communications and in reducing business cycle times.  After a period of
usage, reports can be produced to analyze inefficiencies and bottlenecks in the process flow.  This
information can then be used to streamline the process flow as defined within BPM.

3.7 Application software such as an ERP system can trigger SLAP
BPM requests.

Requests can be made that are automatically based on certain conditions arising in application
software.  BPManager provides an API to initiate these kinds of requests directly from an
application program.  For example, when a record is saved, an order is cancelled, or an invoice
run is completed, the ERP system can automatically make a request or notify the person
responsible for the next step(s). The application software interface is extremely simple.  The
BPManager need only be passed a "trigger point name".  BPManager itself will determine the
requests that will be made based on the trigger.

Examples:

· The inventory level for a part goes below the warning level. Rather than running reports and
checking them periodically, a request is immediately sent to a scheduler to review the re-
order position.

· A credit limit has been exceeded by a new order or shipment...
· An important rush order has been shipped by the shipping department...

3.8 BPM can be used to request application software actions.

This can be done in one of two ways:

· A request made of the request recipient contains an attachment which is a link to an
application software object such as an order or estimate number.

For example,
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1.  An estimator is asked to raise a new estimate.  The link is a job or customer number.
2.  An estimator is asked to modify or cancel an existing estimate.  The link is an estimate

number.
3.  An inventory clerk is asked to cycle count a part.  The link is a part number.

· A special type of 'notification' can be used to directly run an application program.  For
example, a request is made to run an inventory status report overnight.

3.9 Various delivery methods of notification

Those employees that are on the road or people that are not part of the organization can be
notified in different ways:

· Internal (through BPM)
· E-mail
· Fax
· Text message to cellular phone
· Pipex

see
Maintain User: Address TAB

4 BPM Quick Start (Introduction)

4.1 Start the system

After installation of the system, double click the BPM icon on the desktop.

This will open the main screen where you can enter requests, check what is in your work queue
and view all notifications sent to you.

In the default configuration (Panel View), this main screen is split into three parts (from top to
bottom): your work queue, notifications and issued requests.
In the Notebook Configuration, these three parts become three separate TABs or pages.

4.2 Enter users / groups

From the Maintenance menu option select Users.

Click the Create new record button . Enter the User information.

On the Groups TAB click the Add new record button  and select the Groups. Groups can
be created once all users have been entered into the system.

On the Addresses TAB click the Add new record button . Select from the Delivery
Method drop down box which option to use and enter the corresponding address.

4.3 Enter request

Click the Create request button beside the Issued Requests panel, or right click in the
display area for a drop down menu of options. This will work in any of the 3 queues (My Work
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Queue, Notifications and Issued Requests). Enter all information required to enter a
request on the pop up window. (You can use the system with the default requests setup.)

Complete the information for Attachments, Next Step and Notification if desired. To add
any new items to these TAB's click the Add new record button.

If this request can be used in the future you can save it as a Template. Click the checkbox and
enter a Template name.

Clicking the Save Draft button will save this request as a draft for some future release. This will
be indicated by the draft column being set to Yes.
(This will allow the user to set up (develop) a process that is not yet ready for use in the
system).

When all information is entered click the Issue a request button.

The new request will show up as an Issued Request in that corresponding panel and you can
now take further action. The options are cancel the request, edit the request or create a child
request by clicking the appropriate button.

Double clicking a request in any window will open a new window that will display all actions on
this request with complete history. You then have the option to reject, delegate, complete or
cancel this request.

To release draft requests select the appropriate one from the screen and click the
Release Draft button, which will then activate this request and send it to the recipient.

4.4 Request Types

Add your own request types in addition to the default requests that come with the system. The
default request actions of the system are: Request, Cancel, Complete, Delegate, Reject and
Draft.

From the Maintenance drop down menu select Request Types.

Add new request for your own internal usage.
Set the Next Step and Notification information.
You need to set the permissions for this new request by selecting the appropriate group and
action. If no permissions are set up, the new request will not be available to users.

5 User Manual

5.1 Action links

Setup or Maintenance
· Users
· Groups
· Request Types
· Notifications
· Attachments
· Triggers

Delivery options
· Setup of e-mail address for delivery via e-mail of a notification
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Request Options
· Enter a new request

· Attachments

· Next Step

· Notification

· Show my requests

· Show my notifications

· Show request I entered

5.2 General Information

5.2.1 Icons in the system

From the Options Menu, you can choose to view menu buttons such as Save as an image

, an image with text , or as text only  by checking one or two of the two
options.

Standard Icons used throughout the BPM system.

   Request (New item in Database) / Save a Draft of a Request

   Issue a new Request to User

   Reject Request / Delete Notification / Cancel Request

   Show/Hide the search Panel

   Close this screen

   Edit item in the maintenance screen

   View a Parent request from Request view



BPManager - Business Process Management9

© 2003 Slofstra Software Inc.

   Create a Child request from Request view

   Add new record

Delegate Request

Create Child Request

Complete Request

Create Request

Edit

Release Draft

Drop down window selection options

Sort Data in ascending order

Sort Data in descending order

Checked checkbox (Allow or perform option)

Unchecked checkbox (Do not allow or perform action)

Open the calendar window for Date entry

5.2.2 Main

BPM main system.

This is the default screen that will show on system startup.
From here all activity can be initiated and reviewed.

The system default is set to Panel view.
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To change the view, select View from the top of the screen, then select either Show as Panels
or Show as Notebook.

Notebook view.
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Menu options

The File Menu

The Maintenance Menu

The View Menu
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The Options Menu

The Help Menu

5.3 Application

5.3.1 Login

Username and Password  must be set up by the system administrator before you can
access the system.

To start the system double click the BPM Client Icon on your desktop.

The login screen will display.

Enter your user name and password and press Enter or click Login.
You can check Remember Password so the system will remember your password the next
time you log in. For better security, leave this checkbox unchecked.
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If you enter a wrong password, the system will respond with this error. Obtain the
correct password from the system administrator or re-type it if you made a typing error.

5.3.2 Password Change

You can change your own password once you are an established user of the BPM system.

From the Options menu select Change password...

Enter the old and new password and retype it for confirmation.
Click the Change Password button to change or Cancel to exit without changing.

5.3.3 Exit & Logout

The Logout option in the File Menu will take you back to the login screen, where you can login
again.
The Exit option in the File Menu will exit the BPM system and finish this session.

5.3.4 New Request

Add a new request to the BPM system.

From the File Menu select the Create New Request option or click the Create New Request

button  beside the Issued Requests screen.

New request entry screen:
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See: Request TAB
Attachments TAB
Next Step TAB
Notify TAB

5.3.4.1 Request TAB (New Template)
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Request Template: To use a request template, select one from the drop down box.
If the desired template is not in the list, the user can
create a new template.
To create a request without a template, simply leave the field blank.

Request Type: Select from the drop down window.
If the desired request type is not available, the user can
create a new request type.

Subject: Enter a subject heading (usually a quick summary of the request).

Body: Enter any information into the Body text box.

Recipient: Select either User or Group, and then select the appropriate User or
Group from the drop down box.
If the desired User or Group is not available, create a new group or
create a new user.

Priority: Select the appropriate priority from the drop down window (Normal is
the default).

Due Date: Enter the due date. To use the calendar click the calendar icon and
select the appropriate date by double clicking it.
The bottom of the recipient's main screen will show when he or she has
passed the due date on any request, and the overdue request will be
shown in red in the sender's and receiver's work queues.

Save as Template: Select this check box to save this request as a new template so that if
similar requests are issued in the future, the same information does not
need to be re-entered. Enter the Template name in the Template
Name field. For future requests, this request will be available in the
Request Template drop down box.
 Any Request showing in the Issued Request panel on the main screen
can be saved as a Request Template. Highlight the request and right
click the mouse, then select Save as Template from the drop down
menu and enter a Template name.

To save the request as a draft, click the Save Draft button and the request will be added to the
Issued Requests screen, but will not yet be sent out to the recipient.

If the request is complete, click the Issue Request button.
Or, add attachments, next steps, or notifications.

5.3.4.2 Attachments TAB
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To add a new attachment click the Add new Record button  .
This will bring up a new window.

Attachment Type: Select from the drop down window options.
If the desired Attachment Type is not available, see
Maintain Attachment Type to add a new type.

File: Enter the file name or click the Choose a file to attach button .
Select a file from your computer and press Open.

Note: Enter any text pertaining to the attachment.

When all selections are completed click the Save & Exit button.

5.3.4.3 Next Step TAB
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Next Steps can be added to any request.  A next step is a request that is sent automatically
following the completion (or rejection or delegation) of the prior request.
For example, you might send out a request for an employee to review a report for errors and
make any necessary corrections.  You might add a next step so that when the employee is
finished reviewing and presses Complete, a request is sent automatically to the printer asking
him or her to print the report.

To delete a step from the next step window, select the desired step and click the Delete button

.

To add a new Next Step, press the Add new record button .

On Action: Select from the drop down window. This determines when the next step
will be sent.  For example, select Complete and the next step will be
sent as soon as the first request is completed.

Next Request Type: Select from the drop down window.
If the desired request type is not available, the user can
create a new request type.

Recipient User: The user or group who will be receiving the next step request. Select
either User or Group, and then select the appropriate user or group
from the drop down box.

Next Priority: Select from the drop down window.

Next Subject: Enter a subject heading (usually a quick summary of the request).

Next Body: Enter any information into the Body text box.

Draft: Check the draft box if the next step request is a draft.  Instead of being
sent, the request will be added to the sender's Issued Requests screen
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where it can be edited, deleted or sent out.

Click the Save & Exit button to save the new step entered.

5.3.4.4 Notify TAB

Notifications can be added to any request.  A notification is a message that is sent out
automatically to a specific user or group once a request has been completed (or rejected or
delegated), or when a certain request has been sent out.
For example, a request can be set up so that when the recipient fulfills the request and selects
Complete, a notification is sent to the sender, simply informing him or her that the request has
been completed.

To delete a notification from the notification window, select the desired notification and click the

Delete button .

To set up a notification to be sent automatically, select the Add new record button .

This will bring up a new window.
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On Action: Select from the drop down window. This determines when the
notification will be sent.  For example, select Complete and the
notification will be sent as soon as the request is completed.

Recipient: Check User or Group and select who the notification should be sent to.

Notification Template: Select from the drop down window.
If the desired template is not available, the user can
create a new notification template.

Click the Save & Exit button to add the notification.

5.3.5 Request Screen

The screen is split into 3 working sections.



User Manual 20

© 2003 Slofstra Software Inc.

My Work Queue (Top): Requests in your current work queue.

Notifications (Middle): Notifications sent to you.

Issued Requests (Bottom): Requests that you have issued to others or yourself.

5.3.5.1 My Work Queue

Check the appropriate boxes to see the data in your work queue. If you would like to see all the
completed requests select the Completed check box. All requests that have been completed by
you or by someone in the recipient group will be displayed on the screen.

To respond to a request displayed on the screen, select the request with a mouse click, then
click the appropriate action button on the right hand side of the screen.

You can reject , delegate , create a child request , or complete  the
highlighted request.

5.3.5.1.1  Create Child Request

Requests can be linked together as a chain.
When a request in a chain is sent out, the request it is linked to is called its Parent Request,
and any request that is linked to it is called its Child Request.

To create a Child Request, select the request to link it to in either the My Work Queue screen,

or the Issued Requests screen and press the Create Child Request button . This will open
the New Request screen.

To view a request's Parent Request, double click the desired request in My Work Queue, then

select View Parent .

5.3.5.2 Notifications

This middle section shows all notifications that have been sent to you. You can delete
notifications from the window by selecting them and then clicking the Delete Notification

button .
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5.3.5.3 Issued Requests

Check the appropriate boxes to display Requests that you have Issued that are still Open, or
have been Completed, Rejected, or Cancelled.

To work with a specific request select it with a mouse click.
Use the different action buttons to perform the desired action for the selected issued request.

The options are: Create Request , Cancel Request , View request ,

Create Child request , and Release Draft .

If a request is a draft, the Draft column of the request will display Yes. This means the request
has not yet been sent to the recipient.
To edit the draft, double click on it to open the request screen.
To send the draft to the recipient as a request, click on the draft and select the Release Draft

button .

5.4 Maintenance

The Maintenance menu, found by clicking Maintenance at the top of the main screen, can be
used to change, delete, or add new records to the database.

The Maintenance menu options are only accessible to users who have been granted permission
through the Maintain Group: Function TAB menu option.

Select one of the menu options to begin making changes.
See Maintain:

Attachment Types
Groups
Notification Templates
Program Triggers and Notifications
Request Types
Users

5.4.1 Maintain User
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With this screen the administrator can add a new user to the database, change an existing user,
or delete a selected user. By clicking on the search button the administrator can show/hide the
search window.

The administrator can search for users by entering in any of the available fields to find a specific
or multiple users. After entering the search criteria click the "Search" button.
Clicking the Clear button will show all users in the system.

 Create a new user.

 Delete a selected user from the database.

 Show/Hide the search option window.

 Close the User Maintenance window and return to BPM main screen.

Click the Close button to return to the BPM main screen.

To add a new user, press the Create a new user button, or double click on an existing user to
make changes to that user.
Whether creating a new user, or making changes to an existing one, a new window will open.
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Fill in or change the information in the User, Groups, Addresses tabs.

5.4.1.1 User TAB

Fill in or edit the User Name, First Name and Last Name.

The User Name is what the user will use to login.

If a new user is being created, the User TAB will also have a field for the new user's password.

To change the password of an existing user, see Password Change.

5.4.1.2 Group TAB

Clicking the Group TAB will allow the user to make changes to the groups in which the user is
included.

To add the user to a new group, press .
To change which group(s) the user is a part of, select one of the groups listed, and press Edit

.
This will open a new window.
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Select a new Group Id from the drop down window by clicking the arrow on the displayed
name window.

If the desired Group is not available, add a new group through the Maintain Group menu option.

Or, to remove the user from a group, highlight one of the groups listed, and select delete .

5.4.1.3 Address TAB

Clicking the Addresses TAB will allow the user to make changes to the contact addresses of the
selected user.

 Click the Add new record button to add a new address to the user or

 Click the Edit button to change a selected address.
This will open a new window:

Select address method from the Delivery Method drop down window. Enter the appropriate
address corresponding to the Delivery Method.

Internal: No address is required.
E-mail: Enter the e-mail address for the person that is to receive an e-mail

informing them of the request.
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Fax: Enter the fax number where to fax the request notification.
Pipex: ????

5.4.2 Maintain Group

This option allows the administrator to set up Groups of people within the BPM system.

 Create a new group.

 Delete a selected group from the database.

 Show/Hide the search option window.

 Close the Group Maintenance window. Return to BPM main screen.

To change an existing Group, highlight the Group and then double click it with the mouse to
open the maintenance screen.

Adding a new group or changing an existing one will open the maintenance screen .

Fill in or change the information on the Group, Functions, Request Type, or Members TABs.

5.4.2.1 Group TAB

Select the Group TAB on the Add/ Change Group Maintenance screen.
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To Add a new Group enter the new name and a description for the Group.

5.4.2.2 Function TAB

Select the Function TAB on the Add/ Change Group Maintenance screen.
This TAB is used to edit which functions the group is allowed to complete.
For example, if maintain_request _type is added as a permission, all members of the group
will be able to access the Maintain Request Type menu option and make changes to the
database's request types.

 Click the Add new record button to add a new function to the Group or

 Select a function and click the Edit button to change the function.

This will bring up a new window:

Select the Function from the drop down window.
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When the selection is made click the Save & Exit button.

5.4.2.3 Request Type TAB

Select the Request Type TAB on the Add/ Change Group Maintenance screen.
This TAB is used to give the selected group permission to respond to certain request types in
certain ways.

 Click the Add new record button to add request type permissions to the Group

 Click the Edit button to change request types permissions.

This will bring up a new window:

Select a Request Type from the drop down box.
If the desired request type is not available, see Maintain Request Type to add a new request
type.

Select an Action from the drop down box.
This will allow the selected group to respond to this request type with this action.
For example, if a permission is not set up to allow a group to reject a certain request type, then
if a user in that group attempts to reject a request of that type, he will receive an error
message, and the rejection will not be completed.

To allow a group to perform all actions on this request type, select All in the Action drop-down
box.

When the selection is made, click the Save & Exit button.

Multiple permissions can be added to a group.  Click the Add new record button to add
another new request type permission.

These permissions can also be changed or updated through the Maintain Request Type menu
option (see Maintain Request Type: Permission TAB).

5.4.2.4 Members TAB

Select the Members TAB on the Add/ Change Group Maintenance screen.

 Click the Add new record button to add members to the group or

 Select an existing user, and press the Edit button to change the group member to a
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different user

This will bring up a new window:

Select the new user from the drop down window. When the selection is made, click the Save &
Exit button.

5.4.3 Maintain Request Type

With this screen a user can set up the request types of the system.

 Create a new Request Type.

 Delete a selected Request Type from the database.

 Show/Hide the search option window.

 Close the Request Type Maintenance window. Return to BPM main screen.
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5.4.3.1 Add New Request Type

Enter the Description for the new Request type.

5.4.3.2 Permissions TAB

Clicking the Permissions TAB will allow the user to add or change permissions.

Permissions are set up on a request type to allow certain groups to respond to requests of that
type in certain ways.

 Click the Add new record button to add new Permissions or

 Click the Edit button to change existing Permissions.
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Select a Group from the drop down box.
If the desired group is not available, see Maintain Group to add a new group.

Select an Action from the drop down box.
This will allow the selected group to respond to this request type with this action.
For example, if a permission is not set up to allow a group to reject a certain request type, then
if a user in that group attempts to reject a request of that type, he will receive an error
message, and the rejection will not be completed.

To allow a group to perform all actions on this request type, select All in the Action drop-down
box.

Multiple permissions can be added to a request type.  Press Save to add the new permission
and return to the Request Type Maintenance screen.  Then press the Add new record button
again to add another new permission.

These permissions can also be changed or updated through the Maintain Group menu option
(see Maintain Group: Request Type TAB).

5.4.3.3 Mandatory Attachments TAB

Clicking the Mandatory Attachments TAB will allow the user to add or change what
attachments must be attached either to the request or to the request response before one or
the other is sent.
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 Click the Add new record button to add attachments or

 Click the Edit button to change existing attachments.

This will open a new window:

Select the appropriate Attachment Type from the drop down window.
If the desired attachment type is not available, see Maintain Attachment Type to add a new
type.

Select the appropriate Action from the drop down window.
If the attachment must be attached to the request before it is sent, select Request as the
action.
If the attachment must be attached to a specific type of request response, such as Complete
or Reject, select that response as the action.

Click the Save & Exit button.
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5.4.3.4 Next Step TAB

Clicking the Next Step TAB will allow the user to add or change next step procedures.

 A next step is a request that is sent automatically following the completion (or rejection or
delegation) of the prior request.
Use this TAB to add next steps that will automatically be added to any request of this type.

 Click the Add new record button to add new steps or

 Click the Edit button to change existing steps.

This will open a new window:

Select the desired information from each of the drop down windows, and fill in the Next
Subject and Next Body (see New Request: Next Step TAB for more information).
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Click the Save & Exit button.

5.4.3.5 Notification TAB

Clicking the Notification TAB will allow the user to add or change notification procedures.

A notification is a message that is sent out automatically to a specific user or group once a
request has been completed (or rejected or delegated), or when a certain type of request has
been sent out.
Use this TAB to add notifications that will be added automatically to any request of this type.

 Click the Add new record button to add new notifications or

 Click the Edit button to change existing notifications.

Select the desired information from each of the drop down windows (see New Request:
Notify TAB for more information).

5.4.4 Maintain Notification Template

With this screen a user can add or change Notification Templates.  A Notification Template can
be used when adding notifications to a request (see New Request: Notify TAB) or to a request
type (see Maintain Request Type: Notification TAB).
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 Create a new Notification Template.

 Delete a selected Notification Template from the database.

 Show/Hide the search option window.

 Close the Notification Template Maintenance option. Return to BPM main screen.

To change an existing Notification Template select it from the window and double click it to
open the maintenance screen.

5.4.4.1 New Notification Template

Enter the Subject, Delivery Method and the Body for the new template.
If any Mandatory Attachments are required, select the Mandatory Attachments TAB.
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5.4.4.2 Mandatory Attachments TAB

 Click the Add new record button to add attachments or

 Click the Edit button to change existing attachments.

Select the appropriate Attachment Type from the drop down window.
If the desired attachment type is not available, see Maintain Attachment Type to add a new
type.
Click the Save & Exit button.

5.4.5 Maintain Attachment Type
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 Create a new Attachment Type.

 Delete a selected Attachment Type from the database.

 Show/Hide the search option window.

 Close the Attachment Type Maintenance option. Return to BPM main screen.

To change an existing Attachment Type, select it from the window and double click it to open
the maintenance screen.

5.4.5.1 New Attachment Type

Description: Enter a short description of the attachment type.

Extension: Enter the attachment type extension (ex. .gif, .xls, .doc).

Hyperlinks: If the attachment is a link to another program, enter the link in the
Hyperlink (Edit) field or the Hyperlink (View) field.

Can Upload: Select this box if the attachment is a document to be uploaded.
For example, a file with an extension can be uploaded, but if the
attachment is simply a link to another program, it cannot be uploaded.

Inactive: If the Inactive box is checked, the attachment type cannot be used.

5.4.6 Maintain Program Triggers and Notifications

Requests and Notifications can be sent not only by users, but by external programs.
Use this menu option to set up Triggers that external programs will act upon.
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 Create a new program trigger.

 Delete a selected program trigger from the database.

 Show/Hide the search option window.

 Close the Program Triggers and Notifications Maintenance window. Return to BPM main
screen.

To change an existing Program Trigger select it from the window and double click it to open
the maintenance screen.

5.4.6.1 New Program Triggers

Use this TAB to add program triggers that will allow the programs to trigger requests.
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 Click the Add new record button to add new Program Triggers or

 Click the Edit button to change existing Program Triggers.

Select from the drop down window the Next Request Type, Next Recipient Group, Next
Recipient User and click the Draft checkbox if this is for a draft.

5.4.6.2 Program Trigger Notifications TAB

Use this TAB to add program triggers that will allow the programs to trigger notifications.

 Click the Add new record button to add new Program Trigger Notifications or

 Click the Edit button to change existing Program Trigger Notifications.
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